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1 Введение 

1.1 Настройки декодирования 

 

ПО Pilot Pioneer Expert поддерживает анализ данных различных форматов, например *.RCU, *.DCF, 
*.dtlog, *.CTI, *.CU, *.ddib, файлы Qualcomm, *.GEN и др. Большинство файлов данных необходимо 
декодировать в формат *.ddib для анализа. Пользователи могут выполнять соответствующие 
настройки в зависимости от фактической ситуации, например настройки хранения файлов данных, 
настройки сохранения подробностей сообщений уровня 1/уровня 2 и настройки хранения 
информации о кадрах LTE 

1. Настройки хранения декодированных файлов данных 

Выберите Configuration > Options > General, нажмите кнопку  и укажите целевой каталог для 
сохранения декодированных файлов данных. См. рисунок ниже: 

Рисунок 1-1 Выбор пути хранения 

 

Примечание: указанный путь хранения декодированных файлов данных также используется для 
файлов данных, создаваемых в процессе сервисного тестирования. 

2. Настройки сохранения подробностей декодирования для Layer 1 и Layer 2 

Выберите Configuration > Options > Advanced, установите флажок Save Layer1 and Layer2 message 
details, чтобы сохранять подробности декодирования сообщений уровня 1 и уровня 2. 
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Рисунок 1-2 Настройка сообщений Layer 1/Layer 2 

 

ПО Pilot Pioneer Expert по умолчанию не сохраняет подробности декодирования сообщений уровня 
1 и уровня 2. Пользователю необходимо вручную включить данную опцию для просмотра этих 
данных. 

3. Параметр сохранения GPS-информации 

Если выбрана опция Display High Density GPS Information, будет сохраняться более точная GPS-
информация высокой плотности. Данная опция действительна только для тестирования 
высокоскоростных железных дорог в Китае, и пользователю, желающему получить доступ к данной 
функции, необходимо обратиться в техническую поддержку DingLi. 

4. Настройки хранения информации о кадрах 

Выберите Configuration > Options > Advanced, в разделе Frame Information Storage Settings 
установите необходимые параметры для сохранения соответствующей информации. Укажите, 
сохранять ли информацию о кадрах для сетей NR и LTE. После изменения настроек пользователю 
необходимо выполнить повторное декодирование файлов данных, после чего соответствующая 
информация будет сохранена. 

1.2 Настройки статистического анализа 

Пользователи могут выполнять общие настройки (например, параметры статистики голосовых 
вызовов и сервисов передачи данных) для всех операций анализа данных и статистических 
отчетов. Следуйте приведённым ниже инструкциям: 

1. Изменение свойств KPI 

Выберите Configuration > Options > KPI Properties, чтобы открыть соответствующую страницу 
настроек. Пользователь может изменить параметры в соответствии с фактическими задачами и 
нажать OK для сохранения изменений. 

 

mailto:info-site@akmetron.ru


7 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

Рисунок 1-3 Изменение свойств KPI 

 

2. Изменение алгоритма статистики FTP-сервиса 

Существует два алгоритма для формирования статистики FTP-сервисов (длительность FTP, 
пропускная способность FTP и др.). Выберите Configuration > Options > Algorithms, чтобы открыть 
соответствующую страницу настроек. Пользователь может выбрать любой из алгоритмов в 
соответствии с описанием на странице. Кроме того, пользователь может задать отдельный путь 
хранения для каждого статистического отчёта или установить единый путь хранения для всех 
статистических отчётов. 

Рисунок 1-4 Настройка алгоритма статистики FTP-сервиса 
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1.3 Импорт/экспорт шаблонов 

ПО Pilot Pioneer Expert поддерживает функцию импорта и экспорта шаблонов. Поддерживаются 
следующие типы шаблонов: шаблоны отчётов, шаблоны анализа, шаблоны фильтров, шаблоны сеток 
и шаблоны параметров. Это обеспечивает удобный обмен шаблонами между пользователями Pilot 
Pioneer Expert, а также между различными версиями ПО, и позволяет легко импортировать 
пользовательские шаблоны в обновлённую версию или на другие компьютеры. 

Для экспорта шаблонов выполните следующие действия: 

1. Нажмите кнопку  меню >File>Export Templates, чтобы открыть окно Export 
Templates.  

Рисунок 1-5 Выбор шаблонов для экспорта 

 

 

2. Выберите тип шаблонов в левой части окна и необходимые шаблоны в правой части окна. 

3. Нажмите Export, чтобы сохранить шаблоны в файл формата *.ptmf. 

Рисунок 1-6 Экспорт шаблонов 

 

Для импорта шаблонов выполните следующие действия: 
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1. Нажмите кнопку  меню >File>Import Templates, чтобы открыть окно Import Templates. 

2. Выберите файл *.ptmf на локальном ПК для импорта в Pilot Pioneer Expert. 

Рисунок 1-7 Выбор шаблонов для импорта 

 

2 Управление данными 

Файлы данных, собранные продуктами DingLi, например Pilot Pioneer, Pilot Walktour, Pilot RCU, Pilot 
Scout, могут быть импортированы в ПО Pilot Pioneer Expert для управления данными, 
постобработки и анализа. 

2.1 Импорт лог-файлов 

После декодирования импортированных тестовых данных пользователи могут воспроизводить, 
формировать статистику и анализировать декодированные тестовые данные. 

Выберите один из следующих способов импорта лог-файлов: 

Способ 1: В строке меню выберите File > Import Logfile. Горячие клавиши — "Ctrl+O". 

Способ 2: На панели инструментов нажмите значок Import Logfile  ( ).  

Способ 3: В панели навигации нажмите Data, затем нажмите значок  

Способ 4: В панели навигации выберите Data>Data List> рядом со значком  , чтобы выбрать 
ранее использованный лог-файл. 

Способ 5: Перетащите лог-файл непосредственно в панель Data List. 

Способ 6: Дважды щёлкните локальный лог-файл, чтобы автоматически запустить Pilot Pioneer и 
импортировать лог-файл. Импортированные лог-файлы автоматически отображаются в списке 
Data List. 

 

2.2 Экспорт лог-файлов 

Пользователи могут выбирать и экспортировать лог-файлы в определённые форматы и по 
заданным путям в соответствии с настройками. Выполните следующие действия: 

1. Откройте окно Export Logfile одним из следующих способов: 

• В строке меню выберите File > Export Logfile. 
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• Выберите лог-файл в панели Data List, щёлкните по нему правой кнопкой мыши и 
выберите Export Logfile. 

Рисунок 2-1 Окно Export Logfile 

 

2. Нажмите Add или Delete, чтобы добавить или удалить лог-файлы при необходимости. 

3. Нажмите Template Manager и Settings, чтобы выполнить настройку экспорта лог-
файлов. 

• Template Manager: отображает текущий шаблон экспорта 

• Settings: задаёт параметры для создания и изменения шаблона 

4. После настройки шаблона нажмите Export. В появившемся диалоговом окне задайте 
путь для сохранения лог-файлов. Пользователю не требуется задавать имя файла, так как оно 
генерируется автоматически. 

Рисунок 2-2 Выбор пути сохранения 

 

Нажмите Select Folder, чтобы начать экспорт лог-файлов. После завершения экспорта ПО 
возвращается в окно Export Logfile. Пользователь может продолжить работу или закрыть окно. 

Пользователь может выбрать параметры, события, сигнальные сообщения и другую информацию и 
содержимое для экспорта на соответствующих вкладках и нажать Save. 

Экспорт данных возможен в форматы *.nCTI, *.DTLog, *.CU, *.MDM, *.DLF и другие. Выберите 
формат экспорта в раскрывающемся списке Format. 
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На рисунке ниже показано окно Template Settings: 

Рисунок 2-3 Окно Template Settings 

Рисунок 2-4 Дополнительные настройки 

 

Экспортируемая информация может включать информацию о сетке, имя обслуживающей соты, 
подробности сообщений, исходный код, информацию сканера, структуру, список сот и другую 
информацию. 

Пользователь может нажать Advanced для выполнения дополнительных настроек, например 
настройки диапазона пакетов (Package Range) и параметров выборки (Sample Options). 
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Рисунок 2-5 Настройки экспорта файлов Scanner 

 

На странице Advanced Settings пользователь может 

• нажать Scanner для настройки экспорта данных тестирования сканера. 

 

 

 

 

 

 

 

mailto:info-site@akmetron.ru


13 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

• • нажать Structure, чтобы выбрать тип данных в разделе Structure для экспорта. 

 

Рисунок 2-6 Настройки Structure 

 

• нажать Cell List, чтобы выбрать типы сот для экспорта. 

Выберите тип соты (PCell, SCell или NCell) и информацию о соте для экспорта. Поддерживается 
экспорт TopN сот с возможностью настройки полей сортировки и периода экспорта. 

Рисунок 2-7 Настройки Cell List 

 

2.3 Объединение/разделение лог-файлов 

ПО Pilot Pioneer Expert поддерживает объединение и разделение данных для файлов форматов 
*.rcu, *.ddib и *.dcf. Выберите Tools > Merge/Partition Logfiles, чтобы открыть окно Merge/Partition 
Logfiles. 
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Рисунок 2-8 Окно Merge/Partition Logfiles 

 

2.3.1 Объединение лог-файлов 

ПО Pilot Pioneer Expert позволяет объединять два или более лог-файлов в один. Для объединения 
выполните следующие действия: 

1. Выберите лог-файлы для объединения в окне Merge/Partition Logfiles. 

2. Укажите целевой каталог для сохранения объединённого лог-файла. 

3. Нажмите Merge. 

Примечание: источник данных должен быть с одного и того же устройства и порта. 

2.3.2 Разделение лог-файлов 

ПО Pilot Pioneer Expert позволяет разделять один лог-файл на несколько. Для разделения 
выполните следующие действия: 

1. Выберите лог-файлы для разделения в окне Merge/Partition Logfiles. 

2. Нажмите Partition, чтобы открыть окно Partition Logfiles. 
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Рисунок 2-9 Окно Partition Logfiles 

 

3. Выберите условия разделения, включая разделение по количеству файлов, 
идентификатору устройства, времени и региону. 

4. Нажмите OK. Разделённые файлы сохраняются по заданному пользователем пути. 

2.3.3 Повторное декодирование лог-файлов 

Pilot Pioneer предоставляет возможность повторного декодирования тестовых данных в случае 
изменения некоторых расширенных параметров конфигурации. Данная функция доступна только 
для лог-файлов форматов *.rcu и *.dcf. Если лог-файлы имеют формат *.ddib, повторное 
декодирование не требуется. 

Метод повторного декодирования следующий. 

Щёлкните правой кнопкой мыши по тестовым данным в разделе Data>Data List панели навигации, 
выберите Redecode для повторного декодирования данных. В строке состояния в правом нижнем 
углу Pilot Pioneer отображается ход процесса повторного декодирования. Пользователь также может 
удерживать клавишу Control на клавиатуре для выбора нескольких наборов тестовых данных, затем 
щёлкнуть правой кнопкой мыши по выбранным данным и выбрать Redecode для их повторного 
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декодирования. 

3 Статистический отчёт 

ПО Pilot Pioneer Expert предоставляет мощный модуль статистических отчётов, поддерживающий 
различные методы статистики и типы отчётов для удовлетворения различных требований 
пользователей. Пользователи могут напрямую использовать предопределённые шаблоны для 
формирования статистических отчётов, включая 

• отчёты 5G NR 

• отчёты голосовых сервисов 5G NR 

• отчёты NB-IoT 

• отчёты статистики KPI 

• отчёты сервисов передачи данных 

• отчёты голосовых сервисов 

• отчёты IoT 

• отчёты статистики сот сканера 

• специализированные отчёты 

• пользовательские отчёты 

• редактирование пользовательских отчётов 

Кроме того, пользователи могут создавать собственные шаблоны статистических отчётов и 
формировать отчёты в соответствии с требованиями. 

Пользователь может нажать Report в панели навигации для доступа к функции статистических 
отчётов. 

 

В панели навигации отчётов отображается только часть шаблонов отчётов, и пользователь может 
нажать в правом верхнем углу, чтобы выбрать дополнительные шаблоны. 

В данном разделе на примере KPI Statistics Report, Custom Report и Indoor Measurement Report 
показан процесс формирования статистического отчёта. Процедура выполнения аналогична для 
других типов статистических отчётов. 
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Рисунок 3-1 Statistics Reports 

 

3.1 KPI Statistics Reports Отчёты статистики KPI 

Отчёты статистики KPI предоставляют результаты статистики в различных форматах, например MS 
Excel, MS Word, MS PDF, включая информацию о параметрах, тестируемых сервисах, событиях, 
сообщениях и маршрутах измерений. 

Рисунок 3-2 Отчёт статистики KPI 

 

mailto:info-site@akmetron.ru


18 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

Следуйте приведённым ниже инструкциям: 

1. Выберите необходимые файлы данных. 

Statistics By Files: указывает, что результаты анализа будут сформированы в лог-файл формата *.xls. 

• Нажмите Browse, чтобы загрузить файлы данных с локального диска, или 
нажмите Work Files, чтобы загрузить файлы данных из проектов в левую панель. 

• Нажмите Clear, чтобы удалить все файлы данных, загруженные в левую панель. 

• Нажмите  , чтобы добавить файлы данных из левой панели в правую панель 
для формирования статистического отчёта, или нажмите  , чтобы переместить файлы данных из 
правой панели в левую панель. 

2. После добавления файлов данных в правую панель выберите статистический отчёт и 
нажмите значок  

рядом с Select, чтобы перейти на страницу управления шаблонами. 

Пользователь может задать имя шаблона, выбрать параметры и события для статистики, затем 
нажать Save для сохранения настроек. См. рисунок ниже: 

Рисунок 3-3 Страница управления шаблонами 

 

 

3. После добавления файлов данных и выбора шаблона статистики нажмите Generate 
для формирования соответствующего отчёта статистики KPI. 

Индикатор выполнения будет отображаться в правом нижнем углу, и после успешного завершения 
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отчёт будет автоматически открыт. 

Рисунок 3-4 Отчёт статистики KPI 

 

3.2 Пользовательский отчёт/Предопределённый отчёт 

Pilot Pioneer может использовать предопределённые отчёты для статистики, такие как 5G NR Report, 
5G NR Voice Report и др., либо пользовательские отчёты. Процедура выполнения практически 
одинакова, однако для пользовательских отчётов дополнительно требуется выбрать шаблон из 
раскрывающегося списка. Ниже приведён пример пользовательского отчёта. 

Custom Report используется для формирования пользовательского отчёта на основе 
пользовательского шаблона. 

1. Выберите Report > Custom Reports, чтобы открыть страницу настроек. 

2. Добавьте файлы данных и задайте необходимые параметры, руководствуясь 
описанием в разделе KPI Statistics Reports, выберите шаблон отчёта из раскрывающегося списка 
рядом с Template и нажмите Generate для формирования соответствующего отчёта. 
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Рисунок 3-5 Страница настроек пользовательского отчёта 

 

3.3 Отчёт по внутренним измерениям 

Отчёт по внутренним измерениям предназначен для проведения измерений внутри помещений. 

Выберите Report > Specialized Reports > Indoor Measurement Report, чтобы открыть окно настроек. 
См. рисунок ниже: 

Рисунок 3-6 Страница настроек Indoor Measurement Report 

 

Процедура выполнения аналогична KPI Statistics Report и Custom Report. Пользователи могут 
воспользоваться описанием в разделе KPI Statistics Report для формирования отчёта по 
внутренним измерениям. 
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Для отчёта Indoor Measurement Report пользователь также может нажать значок  в правом 
верхнем углу, выбрать Tool > Indoor Test Manager, чтобы открыть страницу Indoor Test Manager, где 
можно выполнить настройки и сформировать соответствующий отчёт. Кроме того, пользователь 
может добавлять здания, этажи и файлы данных, а также выполнять настройку этажей для 
статистического отчёта. 

Рисунок 3-7 Indoor Test Manager 

 

На данной странице пользователь может: 

1. Добавлять здания и этажи 

• Щёлкните правой кнопкой мыши по Indoor Map и выберите Direct Import, чтобы 
импортировать файлы зданий или этажей с локального ПК, либо выберите Add Building для 
добавления файла здания. 

• Щёлкните правой кнопкой мыши по Indoor Map и выберите Refresh, чтобы 
автоматически загрузить существующие файлы зданий или этажей из пути \LogData\Indoor в левую 
панель. Добавленные файлы зданий и этажей сохраняются в виде папок в каталоге установки Pilot 
Pioneer Expert (\LogData\Indoor). 

• Щёлкните правой кнопкой мыши по зданию и выберите Add Floor для добавления 
файлов этажей. 

• Щёлкните правой кнопкой мыши по этажу и выберите Add Map для добавления 
файлов карты. 

• Щёлкните правой кнопкой мыши по зданию или этажу и выберите Delete для 
удаления здания или этажа и соответствующей папки в каталоге \LogData\Indoor. 

2. Выберите этаж для отображения соответствующей карты этажа и файлов данных в 
левой панели. Карта этажа и соответствующие файлы данных должны находиться в одной папке. 
Pilot Pioneer Expert автоматически сопоставляет карту с файлами данных. 

3. Выберите одно здание, один или несколько этажей и лог-файлы для формирования 
соответствующих отчётов. 

4. Нажмите Statistics, чтобы открыть окно настроек этажей, где пользователь может 
выполнить конфигурацию, если имя этажа в отчёте отличается от заданного пользователем при 
добавлении зданий и этажей. 
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Рисунок 3-8 Окно настроек информации об этажах 

 

3.4 Пакетное формирование отчётов  

Нажмите Report>Generate Report in Batches в панели навигации, затем нажмите значок  для 
открытия соответствующей страницы, где пользователь может задать условия формирования 
отчётов и нажать Generate для формирования отчётов одним нажатием. Это удобный способ 
формирования большого количества отчётов для проектов. 

Рисунок 3-9 Пакетное формирование отчётов 
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4 Функции анализа 

ПО Pilot Pioneer Expert предоставляет множество функций анализа. Пользователь может нажать 
Analysis и дважды щёлкнуть по функции анализа либо навести курсор на функцию анализа и нажать 
появившийся значок , чтобы открыть страницу настроек анализа. См. рисунок ниже: 

Рисунок 4-1 Функции анализа 

 

Результаты анализа отображаются в соответствующем разделе функции анализа. Пользователь 
может щёлкнуть правой кнопкой мыши по результату, чтобы 

• открыть окно Map для просмотра соответствующей информации 

• открыть окно Table для просмотра соответствующей информации 

• экспортировать результат в заданный формат 

В данном разделе описана процедура выполнения анализа для 

• Data Insight 

• Coverage Rate Analysis 

• Overlapping Coverage Analysis 

• MOD3 Analysis 

• Cell Statistics and Analysis 

Процедура выполнения аналогична и применима для других функций анализа. 

4.1 Интеллектуальный анализ 5G 

4.1.1 Анализ сравнения параметров 

Анализ любых двух параметров позволяет сравнить тенденции измерений между выбранными 
параметрами. Чем ближе значение R² к 1, тем лучше качество аппроксимации. 
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1. Нажмите  чтобы задать параметры для осей X и Y, или нажмите  чтобы 
поменять параметры осей X и Y местами. 

Рисунок 4-2 Анализ сравнения параметров 

 

2. Результаты анализа включают график зависимости двух параметров, 
максимальные и минимальные значения осей X и Y, формулу корреляции и значение коэффициента 
детерминации (R-squared). 

3. Пользователь также может выбрать Ref. Line (X) и Ref. Line (Y) для отображения 
значений X и Y в заданной точке. 

Рисунок 4-3 Результаты анализа 
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4.1.2 Статистика и анализ TopN сот 

Статистика и анализ TopN сот основаны на заданных пороговых значениях KPI, при этом 
соответствующий уровень сот (от наилучшей до наихудшей) отображается в табличной форме. KPI, 
отображаемые в таблице результатов анализа, могут быть предварительно настроены 
пользователем и включают показатели покрытия, параметры, события и др. 

Выполните следующие действия: 

1. Выберите технологию сети, чтобы перейти на соответствующую страницу, где пользователь 
может задать необходимые условия. 

2. Настройте параметры и события для обслуживающих сот на вкладке Parameter and Event. 
Настройте порог покрытия и уровень покрытия для измерительных выборок на вкладке Coverage, а 
также просматривайте расстояние до сот на карте на основе полевой базы данных. Настройте 
режим сортировки TopN сот и порог квалифицированных сот на вкладке Sort. 

Рисунок 4-4 Статистика и анализ TopN сот 

 

Результаты, отображаемые в Table, включают общую длительность, общее расстояние, общий 
уровень покрытия, средние значения параметров и сводную информацию. В верхней левой части 
отображается список сот источника данных, и при выборе одной из сот её подробная информация 
отображается в нижней левой части, а параметры соты и информация о событиях — в правой панели. 
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Рисунок 4-5 Результаты анализа 

 

2. Щёлкните правой кнопкой мыши по соте и выберите Export TopN Cell, чтобы открыть страницу 
экспорта, где пользователь может выбрать параметры, события и количество сот для экспорта. 

Рисунок 4-6 Экспорт TopN сот 
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4.1.3 Data Insight 

На основе собранных тестовых данных и файлов сот Data Insight используется для выявления 
проблем в тестируемых сетях путём анализа выборок, событий, параметров и др. Пользователь 
может задавать различные условия анализа для различных сценариев и фильтровать результаты 
анализа для выявления проблем покрытия сот, интерференции, событий, хэндовера, параметров и 
др. 

Функция поддерживает как данные UE, так и Scanner, при этом для данных Scanner поддерживается 
анализ плохого покрытия, расширенного покрытия, перекрывающегося покрытия, а также покрытия 
боковых и задних лепестков. Выполните следующие действия для проведения анализа: 

1. Дважды щёлкните Data Insight или нажмите соответствующий значок + , чтобы открыть 
страницу настроек. 

Рисунок 4-7 Data Insight 

 

2. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, 
нажать Local File для импорта локальных файлов данных или нажать Delete для удаления 
выбранных файлов данных, добавленных в левую панель. 

3. Задайте имя анализа и сеть. В настоящее время Data Insight поддерживает только 
радиосети доступа LTE и NR. Если импортированные файлы данных не относятся к LTE или NR, они 
будут недоступны для выбора (отображаются серым цветом). 
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4. Выберите файлы сайтов. 

Пользователь может нажать раскрывающийся список рядом с Site File и выбрать файл сайта, 
импортированный в ПО, для анализа, связанного с базовыми станциями, либо нажать значок , 
чтобы импортировать файл сот с локального ПК. 

 

5. Выберите типы анализа. 

Пользователь может перейти на вкладку Analysis и выбрать тип анализа (например, Event Analysis). 
Пользователь может раскрыть тип анализа для просмотра включённых элементов анализа 
(например, FTP Event Analysis, CSFB Event Analysis, RRC Reestablishment Analysis). См. рисунок 
ниже: 

Рисунок 4-8 Выбор типов анализа 

 

6. Задайте пороговые значения анализа. 

Пользователь может перейти на вкладку Threshold для настройки условий анализа. Пользователь 
может дважды щёлкнуть параметр анализа (например, No Coverage), чтобы просмотреть текущие 
пороговые значения параметров или изменить их. 
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Рисунок 4-9 Настройки пороговых значений 

 

7. Просмотр результатов анализа. 

Нажмите Analyze для формирования результатов анализа, которые отображаются в 
соответствующем узле функции анализа. Окно Table открывается по умолчанию. 

Рисунок 4-10 Результаты анализа 

 

Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и выполнить 
соответствующие операции. Для разных узлов анализа доступны разные функции контекстного 
меню. 
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Рисунок 4-11 Функции правого клика  

 

 

• Пользователь может щёлкнуть правой кнопкой мыши по узлу и выбрать Map 
для просмотра подробной информации анализа в окне Map. 

Рисунок 4-12 Окно Map 
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• Пользователь может щёлкнуть правой кнопкой мыши по узлу и выбрать Table 
для просмотра подробной информации анализа в окне Table. 

Рисунок 4-13 Окно Table 

 

• Пользователь может щёлкнуть правой кнопкой мыши по узлу и выбрать Export для экспорта 
результатов анализа в заданный путь. 

• Пользователь может щёлкнуть правой кнопкой мыши по узлу и выбрать Filter, чтобы открыть окно 
Filter, где можно просмотреть алгоритм анализа и условия, сформировать новые результаты 
анализа на основе настроек, а также изменить значок результата анализа и связанные параметры 
отображения (размер и цвет) в окне Map. 

Рисунок 4-14 Окно Filter 
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4.2 Анализ уровня покрытия  

Анализ уровня покрытия используется для проверки измерительных выборок, соответствующих 
заданному стандарту покрытия (в процентах), а также уровня покрытия каждой выборки. 
Выполните следующие действия: 

1. Дважды щёлкните Coverage Rate Analysis или нажмите соответствующий значок  , 
чтобы открыть страницу настроек. 

Рисунок 4-15 Страница настроек Coverage Rate Analysis 

 

2. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, 
нажать Local Files для импорта локальных файлов данных или нажать Delete для удаления 
выбранных файлов данных, добавленных в левую панель. 

3. Выберите UE или Scanner в качестве режима анализа в зависимости от условий. Если 
выбран UE, файлы данных Scanner будут недоступны и отображаться серым цветом. 

4. Задайте сеть. ПО автоматически определяет сеть на основе добавленных файлов 
данных. 

Пользователь может выбрать другой тип сети при необходимости. 

5. Задайте имя анализа и условия покрытия для соответствующей технологии сети. 

Пользователь также может выполнить настройки Filter и Bin. Подробные операции см. в разделах 5 
и 6. 
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6. Нажмите Analyze для формирования результатов анализа, которые отображаются в 
соответствующем узле функции анализа. Окно Table открывается по умолчанию. 

Рисунок 4-16 Результаты анализа 

 

Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и выполнить 
соответствующие операции. 

Рисунок 4-17 Функции правого клика 

 

 

• Результаты, отображаемые в Table, включают результаты покрытия для каждой 
точки измерения и сводную информацию. 
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Рисунок 4-18 Окно Table 

 

 

• Пользователь может щёлкнуть правой кнопкой мыши и выбрать Map для 
просмотра подробной информации анализа в окне Map. 

Рисунок 4-19 Окно Map 
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4.3 Анализ перекрывающегося покрытия 

Анализ перекрывающегося покрытия используется для анализа сот с перекрывающимся 
покрытием, что может вызывать проблемы с текущей обслуживающей сотой, такие как низкий 
уровень сигнала покрытия и низкое использование сетевых ресурсов. Выполните следующие 
действия: 

1. Дважды щёлкните Overlapping Coverage Analysis или нажмите соответствующий 
значок + , чтобы открыть страницу настроек. 

Рисунок 4-20 Страница настроек Overlapping Coverage Analysis 

 

2. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, нажать 
Local Files для импорта локальных файлов данных или нажать Delete для удаления выбранных файлов 
данных, добавленных в левую панель. 

3. Задайте сеть. ПО автоматически определяет сеть на основе добавленных файлов 
данных. 

Пользователь может выбрать другой тип сети при необходимости. Если файлы данных не 
соответствуют выбранной сети, они отображаются серым цветом и недоступны для выбора. 

4. Выберите тип устройства в соответствии с тестовыми данными, включая UE и 
Scanner. 

5. Задайте имя анализа и пороговые значения параметров для анализа. 
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Рисунок 4-21 Настройки на вкладке General 

 

6. Нажмите Analyze для формирования результатов анализа, которые будут загружены в 
соответствующий узел функции анализа. 

a. Результаты анализа отображаются автоматически. 

Рисунок 4-22 Результаты Overlapping Coverage Analysis 
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b. Пользователь может щёлкнуть правой кнопкой мыши по результату анализа в панели навигации 
и выбрать Map или Table для просмотра результатов анализа в окне Map или Table, либо выбрать 
Delete для удаления результата анализа. 

Рисунок 4-23 Функции правого клика 

 c. В окне Table 

• Вкладка Table содержит выборки, соответствующие заданным условиям (в 
верхней части), и подробную информацию о перекрывающихся сотах (в нижней части). 

• Вкладка Chart содержит топ-10 сот по доле выборок с перекрывающимся 
покрытием и сравнение между обычными точками выборки и точками с перекрывающимся 
покрытием. 

• Вкладка Statistics содержит статистические результаты по перекрывающимся 
сотам. 

Рисунок 4-24 Окно Table 

 

d. В окне Map в панели легенды отображается количество сот с перекрывающимся покрытием. 
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Рисунок 4-25 Окно Map 

 

4.4 Анализ Mod3 

Анализ Mod3 используется для анализа коллизий Mod3 в LTE путём экспорта информации о 
положении выборок измерений, NR ARFCN, PCI, RSRP, RSRQ, SINR и др. 

Выполните следующие действия: 

1. Дважды щёлкните Mod3 Analysis или нажмите соответствующий значок +, чтобы 
открыть страницу настроек. 

Рисунок 4-26 Страница настроек Mod3 Analysis 

 

mailto:info-site@akmetron.ru


39 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

2. Задайте имя анализа. ПО автоматически предлагает имя, пользователь может 
изменить его при необходимости. 

3. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, нажать 
Local Files для импорта локальных файлов данных или нажать Delete для удаления выбранных файлов 
данных, добавленных в левую панель. 

4. Задайте условия анализа в соответствии с описанием параметров ниже: 

• SS RSRP: задайте пороговое значение SS RSRP. 

• SS SINR: задайте пороговое значение SS SINR. 

• SS RSRP Diff: задайте разницу значений SS RSRP между соседней сотой и 
обслуживающей сотой. 

• Filter Frequency SSB: фильтрация SSB по введённому значению. Поддерживается 
ввод нескольких значений SSB через запятую. 

• Site File: импортируйте базу данных сайтов, соответствующую лог-файлу. 

• Distance: задайте расстояние в метрах на основе импортированной базы сайтов. 

5. Формирование и просмотр результатов анализа. 

• Нажмите Analyze для формирования результатов, которые будут загружены в узел Mod3 
Analysis. 

• Результаты анализа автоматически отображаются в таблице по номеру канала. 

Рисунок 4-27 Результаты Mod3 Analysis 

 

 

 

 

mailto:info-site@akmetron.ru


40 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

• Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и 
выполнить соответствующие операции. 

Выберите результат анализа и нажмите Table для отображения окна Table, которое включает 
общее количество выборок и долю Mod3, Mod4, Mod6 и Mod30, а также подробные данные 
анализа Mod X. 

Рисунок 4-28 Окно Table 

✓ Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и 
выбрать Map для отображения результатов в окне Map. См. рисунок ниже: 

Рисунок 4-29 Окно Map 
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4.5 Анализ загрязнения пилот-сигнала 

На основе тестовых данных UE или Scanner анализ загрязнения пилот-сигнала используется для 
анализа уровня сигнала обслуживающих и соседних сот для сетей 2G/3G/4G/5G. Функция 
анализирует сильные соты или серверы, работающие в заданном пользователем пороге, для 
выявления потенциальных источников загрязнения. Условия определения загрязнения пилот-
сигнала: 

• Условие 1: уровень сигнала сот превышает заданный пользователем порог. 

• Условие 2: разница уровней сигнала между сотами, удовлетворяющими условию 1, находится в 
заданном пользователем диапазоне. 

• Условие 3: количество сот, удовлетворяющих условию 2, превышает заданное пользователем 
значение. Pilot Pioneer Expert поддерживает анализ загрязнения пилот-сигнала для всех 
технологий сети. 

Выполните следующие действия для проведения анализа: 

1. Дважды щёлкните Pilot Pollution Analysis или нажмите соответствующий значок +, 
чтобы открыть страницу настроек. 

Рисунок 4-30 Страница настроек Pilot Pollution Analysis 

 

2. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, 
нажать Local Files для импорта локальных файлов данных или нажать Delete для удаления 
выбранных файлов данных, добавленных в левую панель. 
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3. Задайте сеть. ПО автоматически определяет сеть на основе добавленных файлов 
данных. 

Пользователь может выбрать другой тип сети при необходимости. Если файлы данных не 
соответствуют выбранной сети, они отображаются серым цветом и недоступны для выбора. 

4. Выберите UE, Scanner или UE+Scanner в качестве режима анализа в зависимости от 
условий. 

Если выбран UE, файлы Scanner будут недоступны и отображаться серым цветом. 

5. Задайте условия анализа на основе описания параметров ниже: 

a. Analysis name: задайте имя анализа. 

b. Bin Settings: нажмите значок рядом с Bin Settings, чтобы открыть окно Bin Template, где 
пользователь может задать тип Bin (Time, Distance или Grid), указать размер Bin и выбрать способ 
расчёта параметра (Average, Min или Max). 

c. Filter: нажмите значок рядом с Filter и выберите тип фильтрации для отбора данных по множеству 
предопределённых условий на основе параметров, времени, региона, состояния, сервиса, соты, 
комбинации и диапазона условий. 

d. Parameter Threshold: 

• RSRP: задайте пороговое значение RSRQ. 

• SINR: задайте пороговое значение RSRP. 

• Cell count: задайте порог количества сот, удовлетворяющих ранее заданным условиям. 

• Difference: задайте разницу значений между соседней и обслуживающей сотой на основе 
выбранного параметра (например, RSRQ). 

Примечание: отображаемые параметры в разделе Parameter Threshold различаются в зависимости 
от выбранной сети. 

e. Rules within Bin Unit: 

• Use Parameter Average value: использовать среднее значение параметра для определения 
наличия загрязнения пилот-сигнала в единице Bin. 

• Use Sample Ratio: использовать долю выборок с загрязнением пилот-сигнала для определения 
наличия загрязнения в единице Bin. 

6. Нажмите Analyze для формирования результатов анализа, которые будут загружены в 
узел Pilot Pollution Analysis. 

 

 

 

 

 

 

 

mailto:info-site@akmetron.ru


43 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

Рисунок 4-31 Результаты анализа 

 

• Результаты анализа автоматически отображаются в таблице. 

• Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и 
выбрать Map или Table для просмотра результатов в соответствующих окнах, выбрать Export для 
экспорта результатов или Delete для удаления результата. Для разных узлов функции контекстного 
меню могут отличаться. 

Рисунок 4-32 Функции правого клика 

 

• • Пользователь может щёлкнуть правой кнопкой мыши по узлу Frequency и 
выбрать Map для отображения информации о загрязнённых сотах. Щёлкните правой кнопкой мыши 
по параметру в узле Frequency и выберите Map для отображения значений выбранного параметра. 
См. рисунок 4-32. 
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Рисунок 4-33 Загрязнённые соты 

 

Рисунок 4-34 Значение параметра 
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• Пользователь может щёлкнуть правой кнопкой мыши по узлу Frequency и выбрать Table для 
отображения общего уровня загрязнения, информации о зонах загрязнения и подробной 
информации о загрязнённых сотах. Щёлкните правой кнопкой мыши по параметру в узле Frequency 
и выберите Table для отображения среднего значения выбранного параметра для точек с 
загрязнением. 

Рисунок 4-35 Детализация результатов анализа 

 

Рисунок 4-36 Максимальное среднее значение RSRP 

 

4.6 Анализ покрытия сот 

На основе тестовых данных UE или Scanner анализ покрытия сот используется для анализа уровня 
сигнала сот. Покрытие сот проверяется посредством статистики и анализа параметров, таких как 
BSIC, PN, PSC, CPI и PCI. Существует три типа статистических результатов: Parameter, TopN и 
Serving Neighbor (только для UE). Для данных UE результаты анализа покрытия обслуживающих и 
соседних сот могут отображаться отдельно в разделе Serving Neighbor. 

Результаты могут отображаться в виде таблицы, карты и графика. Выполните следующие действия 
для проведения анализа покрытия сот: 
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1. Дважды щёлкните Cell Coverage Analysis или нажмите соответствующий значок +, 
чтобы открыть страницу настроек. 

Рисунок 4-37 Страница настроек Cell Coverage Analysis 

 

2. Добавьте файлы данных. 

Пользователь может нажать Project Files для импорта файлов данных, уже загруженных в ПО, 
нажать Local Files для импорта локальных файлов данных или нажать Delete для удаления 
выбранных файлов данных, добавленных в левую панель. 

3. Задайте сеть. ПО автоматически определяет сеть на основе добавленных файлов 
данных. 

Пользователь может выбрать другой тип сети при необходимости. Если файлы данных не 
соответствуют выбранной сети, они отображаются серым цветом и недоступны для выбора. 

4. Задайте условия анализа. 

a. Перейдите на вкладку General, чтобы задать имя анализа и частоту. 

Примечание: параметр Frequency является необязательным. Если он не задан, результаты анализа 
включают соты всех частот, присутствующих в файле данных. Если указано конкретное значение 
частоты (например, 38350), результаты анализа будут включать только соты с указанной частотой. 
Для ввода нескольких значений используйте запятую (например, 38350,37900). См. рисунок ниже: 
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Рисунок 4-38 Настройки условий анализа 

 

b. Нажмите Advanced, чтобы настроить Filter и Bin. 

Для получения подробной информации о настройках фильтрации и биннинга см. разделы 5 и 6. 

Пользователь может нажать раскрывающийся список рядом с Site File и выбрать файл сайтов, 
импортированный в ПО, для анализа, связанного с базовыми станциями. 

Рисунок 4-39 Вкладка Advanced 

 

5. Нажмите Analyze для формирования результатов анализа, которые будут загружены в 
узел Cell Coverage Analysis. 
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a. Результаты анализа отображаются автоматически. 

b. Для результатов анализа данных UE предусмотрены три типа детализации. В 
качестве примера используется LTE. 

• Parameter for PCI: отображает результаты анализа по параметрам для всех сот, 
идентифицируемых комбинацией частоты и скремблирующего кода. 

Рисунок 4-40 Parameter for PCI 

 

• TopN for PCI: отображает топ-N (например, 1-е, 2-е и 3-е места) значений 
уровня сигнала по параметру. 

Рисунок 4-41 TopN for PCI 

 

• • Serving Neighbor for PCI: отображает результаты анализа для обслуживающих 
и соседних сот. 
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Рисунок 4-42 Serving Neighbor for PCI 

 

• • PCI for Carrier: отображает результаты анализа по номеру радиочастотного 
канала, идентифицируемому комбинацией RF channel number и значения PCI. 

Рисунок 4-43 PCI for Carrier 

 

c. Пользователь может щёлкнуть правой кнопкой мыши по узлу результата и 
выполнить необходимые операции. 
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Рисунок 4-44 Функции правого клика 

 

• Щёлкните правой кнопкой мыши по конечному узлу и выберите Map для 
отображения результатов анализа на карте. 

Рисунок 4-45 Результаты анализа на карте 

 

• Щёлкните правой кнопкой мыши по конечному узлу и выберите Table для 
отображения результатов анализа в таблице. 

В таблице используются два типа параметров: основные и вторичные. Параметр, имя которого 
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совпадает с соответствующим узлом, является основным параметром, остальные — вторичными. 
Значение основного параметра является фактически измеренным значением, тогда как значения 
вторичных параметров могут быть либо фактическими, либо унаследованными (дублированными) 
от предыдущей выборки. 

Рисунок 4-46 Результаты анализа в таблице 

 

• Щёлкните правой кнопкой мыши по конечному узлу и выберите Statistics для 
отображения результатов анализа в виде графика. 

Рисунок 4-47 Результаты анализа в виде графика 

 

4.7 Пользовательский анализ 

Pilot Pioneer Expert версии V10.1 и выше поддерживает пользовательский анализ. Пользователь 
может задавать условия анализа, включая параметры, KPI и др., в соответствии с требованиями. 
Основные возможности пользовательского анализа: 
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 Обеспечивает гибкую настройку анализа. 

 Позволяет реализовать различные сценарии анализа. 

 Пользователь может заранее задать условия анализа (параметры, KPI, события). 

 Встроенный Filter с условиями для обработки данных. 

 Несколько режимов отображения (Charts, GIS и др.). 

Выполните следующие действия: 

1. Нажмите Analysis и дважды щёлкните Custom Analysis, чтобы открыть страницу 
настроек. См. рисунок ниже: 

Рисунок 4-48 Окно Custom Analysis 

 

2. Добавьте лог-файлы. 

Пользователь может нажать Project Files для импорта лог-файлов, уже загруженных в ПО, нажать 
Local Files для импорта локальных лог-файлов или нажать Delete для удаления выбранных лог-
файлов, добавленных в левую панель. 

3. Filter: пользователь может нажать раскрывающийся список рядом с Filter и выбрать 
шаблон фильтра, настроенный на вкладке Filter, либо нажать значок , чтобы создать шаблон 
фильтра. 

4. Site: пользователь может нажать раскрывающийся список рядом с Site и выбрать базу 
сайтов, импортированную на вкладке Layer, либо нажать значок , чтобы импортировать базу сайтов 
с локального ПК. 

5. Добавление шаблона анализа. 

  : нажмите, чтобы добавить шаблон анализа (необходимо указать имя шаблона). 
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 : нажмите, чтобы удалить выбранный шаблон. 

 : нажмите, чтобы открыть окно настроек шаблона анализа, где можно задать параметры шаблона, 
такие как сеть, логическое выражение, частота выборки и др. 

Для некоторых шаблонов анализа, требующих расчёта расстояния до соты, необходимо 
импортировать файл сайтов. 

Рисунок 4-49 Настройки шаблона анализа 

 

✓ Parameter: нажмите, чтобы открыть окно Add Parameters, где можно выбрать 
параметр для логического выражения. 
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Рисунок 4-50 Окно добавления параметров 

 

✓ Function: нажмите, чтобы открыть окно Add Functions, где можно выбрать функцию для 
логического выражения. 

Рисунок 4-51 Окно добавления функций 
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• Type: тип функции (Basic Functions, Set Functions, Mathematical Functions, Cell 
Functions, Service Event Functions, Cell Site Functions). Используйте раскрывающийся список для 
выбора. 

• В центральной панели отображаются переменные выбранной функции, которые 
можно добавить в логическое выражение двойным щелчком. 

• В нижней панели отображается описание функции в зависимости от выбранного 
типа. 

Custom: нажмите, чтобы открыть окно Insert Custom Parameters, где можно выбрать 
пользовательские параметры (например, PointIndex_Start, PointIndex_End, Longitude, PCI и др.) для 
логического выражения. Пользователь также может нажать + для добавления параметра, - для 
удаления выбранного параметра или  для редактирования параметра. 

 

 

Рисунок 4-52 Окно пользовательских параметров 

 

✓ Logic Symbols: после выбора параметра или функции пользователь должен выбрать 
логический оператор (например, +, -, >, AND, OR, NOT и др.) для формирования логического 
выражения. 

✓ Verify Expression: нажмите, чтобы проверить корректность логического выражения. 

✓ Sampling Frequency: частота (или интервал в миллисекундах), используемая для 
фильтрации параметра. Например, если выбран RSRP (с частотой 250 мс), ПО будет выполнять 
фильтрацию параметров для статистики каждые 250 мс. 

✓ Mode Type: тип режима (Time или Mileage). Time означает фильтрацию параметров по 
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заданному интервалу времени, Mileage — по заданному расстоянию. 

✓ Analysis Result: нажмите кнопку для выбора содержимого, отображаемого в окне 
результатов. 

✓ Details in Table: выберите список сот для конкретной сети, чтобы отображать 
информацию о соседних сотах выбранной соты в окне списка сот на вкладке Data. 

6. Нажмите Analyze для формирования результатов пользовательского анализа, 
которые будут загружены в узел Custom Analysis в панели навигации. 

• Результаты анализа автоматически отображаются в таблице. 

•  Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и 
выбрать Table для просмотра результатов, выбрать Delete для удаления результата или выбрать 
Statistics для просмотра статистических результатов. 

• Вкладки Custom Analysis Result содержат общий результат анализа и результат 
анализа по сотам. 

Рисунок 4-53 Страница результатов пользовательского анализа 

 

➢ General analysis result page: Общая информация (например, время начала, время 
окончания, протяжённость, продолжительность и др.) измерительных выборок отображается на 
странице общего результата анализа по PointIndex, Time и Mileage. Общая информация одной 
измерительной выборки отображается в одной строке, однако если данные непрерывны, 
информация о непрерывных данных также отображается в одной строке. Пользователь может 
дважды щёлкнуть строку, соответствующую измерительной выборке, чтобы просмотреть её 
подробную информацию, такую как PC time, EARFCN_DL, PCI, Longitude, Latitude и др. 

➢ Analysis result by cell page: На странице результатов анализа по сотам информация 
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результатов измерительных выборок (например, EARFCN, PCI, имя соты, время теста и пробег, 
соответствующие условиям анализа, количество выборок и др.) суммируется по сотам. 
Пользователь может дважды щёлкнуть строку, соответствующую соте, к которой относятся 
измерительные выборки, чтобы просмотреть её подробную информацию, такую как PC time, 
EARFCN_DL, PCI, Longitude, Latitude и др. 

Рисунок 4-54 Результаты анализа по сотам и их подробная информация 

 

➢ Display analysis results in map window: Пользователь может щёлкнуть правой кнопкой 
мыши в любом месте окна результатов анализа и выбрать Map-All Result для отображения всех 
результатов анализа на карте или Map-Selected Result для отображения результатов, 
соответствующих выбранной строке. 

Рисунок 4-55 Map-Selected Result 
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Рисунок 4-56 Map-All Result 

 

4.8 VoLTE Exception Analysis 

Pilot Pioneer Expert VoLTE Exception Analysis предназначен для анализа исключений, выявленных на 
каждом этапе тестирования VoLTE-сервиса. Могут отображаться подробные данные анализа 
исключений VoLTE, включая PC time, тип аномалии, краткое описание, имя LTE-соты, долготу, 
широту и рекомендации. Кроме того, результаты анализа могут быть представлены в виде графиков. 

 

Следуйте инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните VoLTE Exception Analysis, чтобы открыть страницу 
настроек. См. рисунок ниже: 

Рисунок 4-57 Окно VoLTE Exception Analysis 

 

mailto:info-site@akmetron.ru


59 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

2. Добавьте лог-файлы. 

Пользователь может нажать Project Files для импорта лог-файлов, уже загруженных в ПО, нажать 
Local Files для импорта локальных лог-файлов или нажать Delete для удаления выбранных лог-
файлов, добавленных в левую панель. 

3. Нажмите Analyze для формирования результата VoLTE Exception Analysis, который 
будет загружен в узел VoLTE Exception Analysis в панели навигации. 

• Результаты анализа автоматически отображаются в Table. 

• Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и 
выбрать Table для просмотра в окне Table или Delete для удаления результата. 

• Вкладка Summary отображает сводные результаты анализа и поддерживает 
представление в виде столбчатых/круговых диаграмм или в процентном виде. 

• Вкладка Detail отображает подробную информацию по каждому аномальному 
измерению, включая долготу, широту, время, информацию о соте до и после перехода сети в 
2G/3G. 

• Вкладка tp Total отображает сводные результаты анализа в табличном виде. 

Рисунок 4-58 Результаты анализа VoLTE 

 

4.9 LTE Data Exception Analysis 

LTE Data Exception Analysis в основном используется для анализа данных LTE drive test, выявления 
аномальных событий в сети LTE и анализа вероятной первопричины на основе соответствующих 
событий или параметров, заданных в системе. В настоящее время функция используется для 
анализа падений LTE-соединения, анализа аномальной пропускной способности и анализа ошибок 
хэндовера. Причины исключений и их процентное соотношение отображаются в виде диаграмм. 
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Следуйте инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните LTE Data Exception Analysis, чтобы открыть 
страницу настроек. См. рисунок ниже: 

Рисунок 4-59 Окно LTE data exception analysis 

 

На левой панели отображаются лог-файлы для формирования статистики, а на правой панели — 
параметры анализа исключений, которые необходимо настроить. 

2. Добавьте лог-файлы. 

Пользователь может нажать Project Files для импорта лог-файлов, уже загруженных в ПО, нажать 
Local Files для импорта локальных лог-файлов или нажать Delete для удаления выбранных лог-
файлов, добавленных в левую панель. 

3. Нажмите Analyze для формирования результата LTE data exception analysis, который будет 
загружен в узел LTE Data Exception Analysis в панели навигации.  

• Результаты анализа автоматически отображаются в Table. 

• Пользователь может щёлкнуть правой кнопкой мыши по результату анализа и выбрать 
Table для просмотра в окне Table или Delete для удаления результата. 

• Вкладка Low Throughput Details отображает подробную информацию по каждому случаю 
низкой пропускной способности, включая проблему, время, категорию причины, краткое описание, 
детализацию и др. При выборе записи в центральной панели такие параметры, как RSRPS 
обслуживающей соты, PCI обслуживающей соты, широта и долгота, отображаются в правой панели. 
В левой панели отображаются столбчатые диаграммы с долями и количеством причин низкой 
пропускной способности. 
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Рисунок 4-60 Результаты LTE data exception analysis 

 

4.10 Qualified Coverage Analysis 

На основе данных UE или Scanner TopN анализ Qualified Coverage Analysis используется для 
анализа тестовой области, соответствующей пользовательским условиям покрытия и 
интерференции для сетей 2G/3G/4G. 

Следуйте инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните Qualified Coverage Analysis или нажмите 
соответствующий значок +, чтобы открыть страницу настроек. См. рисунок ниже: 

Рисунок 4-61 Окно Qualified coverage analysis 
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2. Выберите файл сайта, соответствующий тестовым данным. 

3. Задайте условия анализа на основе описания параметров в разделе 18.19 
документации A1.Pilot Pioneer Expert User Manual V10.5. 

4. Сформируйте и просмотрите результаты анализа. В таблице отображаются 
статистические и детальные результаты анализа тестовой области и обслуживающей соты, 
удовлетворяющие условиям анализа. В окне карты представлена визуализация сот и маршрута 
тестирования. 

В окне карты серый маршрут обозначает тестовый маршрут, а серая сота — обслуживающую соту 
тестовых данных. При нажатии на серую соту выделяется тестовая область и точки маршрута, 
соответствующие условиям покрытия сети. 

Рисунок 4-62 Результаты анализа 

 

4.11 Difference Value Analysis 

Difference Value Analysis используется для сравнения и анализа разницы измеренных значений 
между двумя файлами данных, прошедшими один и тот же тестовый маршрут, например разницы 
между RSRP и SINR и др. Это позволяет сравнивать и анализировать производительность различных 
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терминалов, диапазонов, сот и операторов. Функция применима к данным измерений UE и Scanner. 

 

Следуйте инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните Diff Value Analysis или нажмите соответствующий 
значок +, чтобы открыть страницу настроек. См. рисунок ниже: 

Рисунок 4-63 Окно анализа разности значений 

 

 

 

2.  Выберите режим анализа UE-UE, UE-Scanner или Scanner-Scanner в зависимости от 
фактических условий. 

Нажмите           значок для импорта двух logfile, которые необходимо сравнить, в DataSource 
A/B из списка данных в левой панели. При необходимости выберите номер канала (Channel No.) и 
введите его для фильтрации, а также выберите шаблон бинирования в разделе Bin, либо нажмите 
для добавления шаблона Bin. 

3. Выберите один или несколько параметров, которые необходимо сравнить между двумя 
logfile, на вкладке Param. 

4. Установите условия анализа в соответствии с описанием параметров в разделе 18.20 
документа A1.Pilot Pioneer Expert User Manual V10.5. 

5. Сформируйте и просмотрите результаты анализа. 

 

Окно Table отображает фактические значения двух logfile (в одной и той же сетке) и их разность. 
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Окно Map: выберите Map для отображения разницы измеряемых значений между двумя logfile 
вместе с отображением тестового маршрута на карте. 

Рисунок 4-64 Результаты анализа (таблица) 

 

Рисунок 4-65 Результаты анализа (карта) 
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4.12 Анализ эффективных сот 

Поддерживается статистический анализ количества сот, удовлетворяющих заданным 
пользователем порогам покрытия и интерференции. Данная функция предоставляет подробные 
результаты анализа на основе измерений TopN со сканеров и терминалов. Результаты анализа 
могут использоваться для определения необходимости дальнейшего анализа перекрывающегося 
покрытия и плохого покрытия. Следуйте инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните Effective Cell Analysis либо нажмите 
соответствующий значок + для входа в окно настроек. См. рисунок ниже: 

Рисунок 4-66 Анализ эффективных сот 

 

2. Следуйте инструкциям раздела 18.21 документации A1.Pilot Pioneer Expert User Manual 
V10.5. 

3. Формирование и просмотр результатов анализа 

 

Окно Table отображает результаты анализа выборок. Если пользователь нажмёт на выборку, 
информация о сотах, удовлетворяющих заданным условиям, будет отображена в нижней таблице. 
См. рисунок ниже: 

Окно Map: выберите Map для отображения эффективных сот с представлением тестового маршрута. 
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Рисунок 4-67 Результаты анализа (таблица) 

 

Рисунок 4-68 Результаты анализа (карта) 

 

 

4.13 Анализ хэндовера сканируемых сот 

Данный анализ позволяет анализировать и обобщать информацию о хэндовере сот, такую как 
изменение расстояния, значений параметров (например, EARFCN, PCI, RSRP, SINR и др.), 
длительность и т.д. при выполнении хэндовера. Функция предоставляет статистические результаты 
на основе данных TopN сканеров. Применяется для анализа покрытия и мобильности сети. Следуйте 
инструкциям ниже: 

1. Нажмите Analysis и дважды щёлкните Scanning Cell Handover Analysis либо нажмите 
соответствующий значок для входа в окно настроек. См. рисунок ниже: 
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Рисунок 4-69 Анализ хэндовера сот 

 

2. Следуйте инструкциям раздела 18.22 документации A1.Pilot Pioneer Expert User Manual 
V10.5. 

3. Формирование и просмотр результатов анализа 

Окно Table отображает информацию о статистике и деталях хэндовера сот. 

Рисунок 4-70 Результаты анализа (таблица) 

 

Окно Map: выберите Map для отображения результатов анализа хэндовера сот с представлением 
тестового маршрута. 

Выборки, соответствующие условиям анализа, отображаются как Abnormal Route, остальные — как 
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Normal Route. 

 

Рисунок 4-71 Результаты анализа (карта) 

 

 

4.14 Анализ спектра 

Для тестирования очистки спектра в сети 5G на этапе предзапуска требуется анализ активности и 
загруженности сигнала. Pilot Pioneer Expert выполняет анализ интерференции спектра на основе 
данных сканирования. Функциональность дополнена гибкими настройками, такими как 
пользовательский диапазон частот и различные режимы анализа. 

Следуйте инструкциям ниже: 

1. Установите диапазон частот для анализа в окне настроек либо выберите No Limit для 
отсутствия ограничения диапазона. 

2. Выберите Original Parameter или Continuous в качестве режима анализа. 

3. Установите режим и порог для Original Parameter. Как показано ниже, настройки 
параметров означают, что если частоты с RSSI >= -80 составляют 80% или более от общего 
количества частот в данной выборке, то данная выборка определяется как проблемная. 
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Рисунок 4-72 Анализ спектра 

 

4. Окно результатов анализа включает три части. 

Первая часть — сводная таблица, которая отображает общее количество измерений и количество 
проблемных измерений. 

Вторая часть — детали измерений, где отображается, соответствует ли измерение пороговому 
значению, а также номер проблемного канала и другая информация. 

Третья часть — линейный график уровня сигнала конкретного измерения из второй части. 

Диапазон частот, полоса пропускания, максимальные и минимальные средние значения сигнала 
доступны для конкретного сегмента частот при выборе его мышью. 
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Рисунок 4-73 Результаты анализа 

 

4.15 Анализ причин отказов 

Анализ причин отказов используется для анализа причин повторяющихся случаев низкой 
пропускной способности, повторяющегося плохого покрытия, обрывов NR и других проблем с целью 
проверки наличия проблем с расстоянием покрытия, плохого покрытия, отсутствия покрытия, 
проблем антенно-фидерной системы, перекрывающегося покрытия, интерференции Mod3, внешних 
помех и других причин на проблемных участках маршрута. 

Следуйте инструкциям ниже: 

 

1. После выбора данных установите пороги для повторяющихся случаев низкой 
пропускной способности и плохого покрытия в правой панели; задайте пороги для каждой причины 
и типа исключения; выберите или импортируйте файл сайта, затем нажмите кнопку Analyze. 

2. Окно результатов анализа предоставляет подробную информацию об исключениях 
(низкая пропускная способность, покрытие и обрывы NR), включая, но не ограничиваясь: уровень 
сигнала, интерференцию, мощность на участке маршрута, процент перекрытия покрытия 3 и более 
сотами, среднее расстояние до обслуживающих сот, расстояние и угол между проблемной точкой и 
обслуживающей сотой, код причины обрыва NR и др. 

3. Нажмите правой кнопкой на узел результата анализа в панели навигации и выберите 
Map для отображения исключений (низкая пропускная способность, покрытие и обрывы NR) на 
карте. 
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Рисунок 4-74 Анализ причин отказов 

 

Рисунок 4-75 Результаты анализа (таблица) 

 

Рисунок 4-76 Результаты анализа (карта) 
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5 Фильтрация данных 

5.1 Обзор 

 

Данная функция используется для фильтрации данных по множеству предопределённых условий 
на основе параметров, времени, региона, состояния, сервиса, соты, комбинации и диапазона 
условий. Это значительно упрощает анализ данных.  

Рисунок 5-1 Filter 
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5.1.1 Добавление фильтра 

Пользователи могут нажать Filter для входа в окно Filter. См. рисунок ниже: 

Рисунок 5-2 Filter 

 

Для определения фильтра выполните следующие действия: 

 

1. Дважды щёлкните Parameter или наведите курсор на Parameter и нажмите значок + в 
позиции, отмеченной как 1 на рисунке ниже. 

2. Задайте условия фильтрации по необходимости на открывшейся странице, например 
задайте имя фильтра в позиции 2 и задайте выражение как условие фильтра в позиции 3. 

3. Нажмите Save для сохранения настроек. Определённые условия будут отображаться 
в позиции 5 на рисунке ниже. 
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Рисунок 5-3 Определение условий фильтра 

Пользователи могут повторять вышеописанные шаги для создания фильтров по другим условиям, 
например времени, состоянию и т.д. 

5.1.2 Управление фильтрами 

Пользователи могут редактировать или удалять созданный фильтр. 

Рисунок 5-4 Управление фильтрами 

 

1. Редактировать: дважды щёлкните или нажмите значок  для редактирования 
условий фильтра. Если пользователь изменяет имя фильтра, будет создан новый фильтр, который 
отобразится под Parameter. 

2. Удалить: нажмите значок  для удаления выбранного фильтра. 

5.2 Типы условий 

Пользователи могут определять фильтр на основе семи типов условий, включая: 
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• По параметру 

• По времени 

• По региону 

• По состоянию 

• По диапазону условий 

• По сервис 

• По соте 

• По комбинации 

5.2.1 Параметр 

Данный тип используется для фильтрации данных по диапазону значений параметра. Например, 
пользователи могут фильтровать данные по условию "RSRP>-100" или "RSRP>-100 AND RSRQ>-12". 

Пользователи могут нажать значок + для входа на страницу настроек. См. рисунок ниже: 

Рисунок 5-5 Фильтр по параметру 
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1. Имя: имя, заданное здесь, будет отображаться в списке фильтров окна Filter. 
Программа предоставляет имя по умолчанию, но его можно изменить. 

2. Доступные параметры: все поддерживаемые параметры перечислены в разделе 
Available Parameter в зависимости от технологии сети. Можно искать параметры по ключевым 
словам и двойным щелчком добавлять их в Expression. 

3. Операторы: 

• Простые операционные символы: +, -, *, /, =, >, <, >=, <= 

• !=: не равно 

• AND: означает "вместе". Пример: если A TRUE и B TRUE одновременно, то "(A)AND(B)" = TRUE. В 
любом другом случае "(A)AND(B)" = FALSE. 

• OR: означает "любой". Пример: если A или B TRUE, то "(A)OR(B)" = TRUE. Если оба A и B FALSE, то 
"(A)OR(B)" = FALSE. 

• XOR: если A и B одновременно FALSE или TRUE, то "(A)XOR(B)" = FALSE. В противном случае 
"(A)XOR(B)" = TRUE. 

• NOT: означает отрицание. Пример: если A TRUE, то "NOT(A)" = FALSE; если A FALSE, то "NOT(A)" = 
TRUE. 

• Invalid Value: означает отсутствие значения. Например, для некоторых параметров в начале файла 
значение может отсутствовать. Обратите внимание: Invalid Value отличается от значения "0". В ПО 
отображается как "-9999". 

4. Logical expression: логическое выражение состоит из параметров, операционных 
символов (например "+", "-", "="), операторов сравнения (например ">", "<", ">="), логических 
операторов (AND, OR, NOT) и т.д. Примеры:  

• ([SS RSRP]>-100)AND([SS RSRQ]>-12): фильтрует данные, где SS RSRP больше -100 и SS RSRQ 
больше -12. 

• (([SS RSRP]>=-110)AND([SS RSRP]<=-80))AND(([SS RSRQ]>=-14)AND([SS RSRQ]<=-8)): фильтрует 
данные, где SS RSRP в диапазоне -110~-80 и SS RSRQ в диапазоне -14~-8. 

5.2.2 Time 

Этот тип используется для фильтрации данных по времени (UE time или PC time). Пользователь 
может задать начальную и конечную дату/время для фильтрации. Пользователь может нажать 
значок + для входа в настройки. 
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Рисунок 5-6 Фильтр по времени 

 

1. Имя: заданное здесь имя отображается в списке фильтров в окне фильтрации. 
Программное обеспечение предлагает имя по умолчанию, пользователь может изменить его при 
необходимости. 

2. Тип диапазона: 

• В пределах временного диапазона: данные, собранные в указанном временном 
интервале (год/месяц/день, час:минута:секунда), считаются действительными, остальные данные 
— недействительными. 

• До указанного времени: действительными считаются данные, собранные до 
заданного момента времени. 

• Вне временного диапазона: действительными считаются данные, собранные вне 
заданного временного интервала, а данные внутри интервала считаются недействительными. 

• После указанного времени: действительными считаются данные, собранные после 
заданного момента времени. 

• В пределах временного диапазона любой даты: действительными считаются 
данные, собранные в заданном временном интервале времени суток. Это означает, что данные, 
попадающие в указанный интервал любого дня, будут учитываться. 

Примечание: пользователь может нажать «Инструкция» для просмотра описания каждого типа. 

3. Время начала / После времени: задаётся начальный момент фильтрации данных. Все 
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данные после указанного времени будут отфильтрованы. 

4. Время окончания / До времени: задаётся конечный момент фильтрации данных. Все 
данные до указанного времени будут отфильтрованы. 

Примечание: время начала и окончания должны задаваться одновременно, при этом время 
окончания не может быть раньше времени начала. 

5. По времени: выбор источника времени между временем терминала и временем 
компьютера, поскольку для точек измерений используются два типа времени. 

5.2.3 Регион 

Данный тип используется для фильтрации данных на основе файлов регионов. Поддерживаются 
форматы файлов границ и геоданных. Пользователь может фильтровать данные внутри или вне 
выбранной области. 

Пользователь может нажать значок + для перехода к настройкам. 

Рисунок 5-7 Фильтр по региону 

 

1. Имя: отображается в списке фильтров в окне фильтрации. По умолчанию задаётся 
автоматически, может быть изменено пользователем. 
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2. Файлы регионов: пользователь может импортировать один или несколько файлов 
регионов. Система объединяет все загруженные области в единое множество и выполняет 
фильтрацию на основе этого объединения. 

 

3. Фильтрация данных вне объединённого множества: при включении данной опции 
фильтруются данные, находящиеся вне объединённой области. По умолчанию фильтрация 
выполняется внутри объединённой области. 

Примечание: объединённое множество — это совокупность всех уникальных элементов входящих 
регионов. Например, объединение двух регионов представляет собой все области, принадлежащие 
первому, второму или обоим регионам одновременно. 

 

5.2.4 Состояние 

Пользователь может задавать условия на основе событий, параметров или сообщений и 
определять состояние основного условия как открытое или закрытое. Если основное условие в 
состоянии «открыто» срабатывает, система начинает фильтрацию данных, а при срабатывании 
условия «закрыто» — прекращает её. 

 

Рисунок 5-8 Состояния открытия и закрытия 

 

Примечание: по умолчанию состояние условия — закрыто. 

Существуют два типа условий: 

основное условие; 

подусловие. 

Одно основное условие может включать несколько подусловий. Пользователь может добавлять 
несколько основных условий и задавать для них состояния открытия или закрытия. Состояние 
активируется, если выполняются все заданные основные условия. 

 

Пользователь может открыть настройки двойным нажатием или через значок. 
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Рисунок 5-9 Фильтр по состоянию 

 

1. Имя: отображается в списке фильтров, может быть изменено пользователем. 

2. Основное условие: можно добавлять несколько основных условий и задавать их 
состояние. 
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• Добавить — добавление нового основного условия. 

• Удалить — удаление основного условия вместе со всеми подусловиями. 

• Автоматическое завершение — при выборе данной опции состояние 
автоматически переводится в «закрыто», когда условие перестаёт выполняться. В этом случае не 
требуется отдельно задавать закрывающее условие. 

3. Подусловие  

Только при выполнении всех подусловий соответствующее состояние основного условия 
считается действительным. 

Пользователь может нажать кнопку «Добавить» и добавить три типа подусловий: 

 

 

Рисунок 5-10 Типы подусловий 

 

• Параметр: добавление условий на основе логических выражений с параметрами. 
Подробнее см. раздел 5.2.1. 
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Рисунок 5-11 По параметру 
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• Изменение параметра: добавление условий на основе изменения значения 
параметра или перехода значения параметра из одного заданного состояния в другое. 

 
Рисунок 5-12 Условие изменения параметра 

 

• Событие и сообщение: добавление условий на основе одного сообщения или 
события. 

 

Рисунок 5-13 По событию/сообщению 

 

4. Параметры валидности: Если длительность основного условия в состоянии 
«Открыто» меньше значения, заданного в этом параметре, состояние «Открыто» считается 
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недействительным. 

Например, если задать основное условие как RxLevel Sub > -85, выбрать тип в параметрах 
валидности как «Время», а значение как 10, то состояние будет считаться валидным только в 
случае, если параметр превышает -85 не менее 10 секунд. 

Рисунок 5-14 Параметры валидности 

 

Примечание: если выбрано значение NONE, ограничение по длительности состояния отсутствует. 

При настройке условий по состоянию необходимо учитывать следующее: 

• если определено несколько основных условий в состоянии «Открыто», 
применяется только то, которое ближе всего к состоянию «Закрыто»; 

• необходимо задать основное условие «Закрыто» или включить автоматическое 
завершение, иначе фильтрация данных выполняться не будет; 

• при добавлении условия на основе изменения параметра состояние активируется 
только при переходе значения от несоответствия условию к соответствию; 

• Последнее открытие: используется для задания начальной позиции. Позиция 
должна удовлетворять следующим условиям: 

активируется как «Открыто»; 

является ближайшей к позиции, активированной как «Закрыто»; 

• Валидность состояния открытия: указывает, что условия выполняются на всём 
временном или дистанционном диапазоне (в зависимости от типа и размера). 

5.2.5 Диапазон условий 

Используется для фильтрации данных на основе заданного диапазона относительно условия (до, 
после или до и после указанного условия), аналогично подусловиям типа «Состояние». 

Пользователь может перейти к настройкам через соответствующий значок. 

Рисунок 5-15 Фильтр по диапазону условий 
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• Имя: имя отображается в списке фильтров в окне фильтрации. По умолчанию 
задаётся системой, пользователь может изменить его. 

• Триггерное условие: пользователь выбирает тип (например, сообщение события) и 
нажимает «Редактировать» для задания условия. Здесь может быть задан только один тип условия. 
Операция аналогична добавлению подусловия в разделе 5.2.4. 

• Параметры диапазона: задаются после определения триггерного условия: 

• Направление: до, после или до и после; 

• Тип: по точкам выборки, по времени или по расстоянию; 

• Размер: значение времени, расстояния или количества точек выборки. 

Пример: для фильтрации всех точек за 2 секунды до события «Ошибка обновления зоны 
отслеживания» необходимо задать тип условия как событие, выбрать это событие, установить 
направление «до», тип «время» и значение 2. 

Рисунок 5-16 Настройка условий 

 

Примечание: если триггерное условие (например, RSRP < -100) выполняется в течение интервала 
времени, фильтрация применяется относительно указанного направления, а не относительно 
конкретной точки, где условие выполнено. 

5.2.6 Сервис 

Данный тип используется для фильтрации данных на основе тестовых сервисов (например, FTP-
загрузка) или сервисов с дополнительными условиями (например, FTP Download и FTP DL 
Throughput > 10 Mbps). 
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Пользователь может перейти к настройкам через соответствующий значок. 

Рисунок 5-17 Фильтр по сервису 

 

1. Имя: отображается в списке фильтров. Может быть изменено пользователем. 

2. Тип сервиса: выбор тестового сервиса (например, голосовой вызов MO, MT и т.д.). 

3. Свойства сервиса: дополнительное условие фильтрации, например длительность 
сервиса меньше 180 секунд. Параметр необязательный. 

4. Пользовательская задержка: позволяет выбрать два сообщения или события и задать 
интервал времени между ними для фильтрации. 

5. Сеть: выбор сетевой технологии. Значение «Все» означает отсутствие ограничений. 

6. Результат: выбор результата теста сервиса (например, успешно, разорвано). 
Значение «Все» означает отсутствие ограничений. 

5.2.7 Комбинация 

Используется для комплексной фильтрации данных на основе комбинации условий, например: 
параметр + время + сервис.  
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Пользователь может перейти к настройкам через соответствующий значок +. 

Рисунок 5-18 Фильтр по комбинированным условиям 

 

1. Имя: имя отображается в списке фильтров. Может быть изменено пользователем. 

2. Логические операторы: используются для задания связей между условиями: «(», «)», 
«И», «ИЛИ», «>>», «<<», «НЕ». Подробное описание доступно в справке. 

3. Определение комбинированных условий: пользователь может перетаскивать 
фильтры (например, PM1 из параметров и TM0 из времени) в рабочую область и задавать между 
ними логическую связь «И». Изменения исходных условий не влияют на комбинированные и 
наоборот. 

Рисунок 5-19 Определение комбинированных условий 
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5.2.8 Логические операторы 

Существуют следующие логические операторы: И, ИЛИ, >>, <<, НЕ. 

1. И: означает одновременное выполнение условий. Если A истинно и B истинно, то (A И 
B) истинно. В остальных случаях — ложно. 

Рисунок 5-20 Оператор И 

 

2. ИЛИ: означает альтернативу. Если хотя бы одно из условий A или B истинно, результат 
истинный. Если оба ложны — результат ложный. 

Рисунок 5-21 Оператор ИЛИ 

 

3. >>: означает, что множество слева является подмножеством множества справа. Если 
множество истинных значений A является подмножеством B, то результатом будет пересечение, 
соответствующее A. 
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Рисунок 5-22 Оператор >> 

 

 

4. <<: означает, что множество справа является подмножеством множества слева. Если 
множество истинных значений B является подмножеством A, то результатом будет множество B. 

Рисунок 5-23 Оператор << 

 

5. НЕ: означает отрицание. Если A истинно, то НЕ(A) ложно, и наоборот. 

FALSE, then "NOT(A)" is TRUE. 

Рисунок 5-24 Оператор НЕ 

 

Операторы >> и << используются для получения пересечения множеств. 

Пример: если необходимо отфильтровать точки за 2 секунды до события LTE Handover Request и 
при этом учитывать только значения RSRP > -100, то: 

создаётся условие «2 секунды до события» через диапазон условий; 

создаётся условие RSRP > -100 через параметры; 

между ними применяется оператор >>. 
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5.2.9 Сота 

Данный тип используется для фильтрации данных на основе обслуживающей соты и максимальной 
дистанции поиска соты. Например: 

обслуживающая сота: RRU3168-fa; 

максимальная дистанция поиска сот: 5 км. 

Пользователь может перейти к настройкам через соответствующий значок. 

Настройки выполняются согласно описанию в разделе 19.2.8 руководства пользователя системы. 

 

Рисунок 5-25 Фильтр по соте 

 

5.3 Использование фильтров 

1. Пользователь может применять фильтры в окнах таблицы, карты, статистики, отчётов, 
анализа и экспорта данных. В каждом из этих окон доступен менеджер фильтров или выбор фильтра. 

Пример: экспорт данных. 

открыть окно экспорта данных и выбрать фильтр через выпадающий список или добавить новый; 

система отфильтрует точки измерений и выполнит экспорт данных согласно настройкам. 
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Рисунок 5-26 Выбор фильтра 

 

2. Пользователь может нажать значок  в окне фильтрации для формирования 
отфильтрованных данных и загрузки их в систему. При этом сохраняются имя фильтра и время 
генерации. 

Рисунок 5-27 Формирование отфильтрованных данных 

 

Рисунок 5-28 Загрузка отфильтрованных данных 

 

6 Биннинг данных 

6.1 Обзор 
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 Данная функция используется для группировки большого количества значений данных в меньшие 
«интервалы» (бины) и получения среднего (рекомендуется), максимального или минимального 
значения. 

Пользователь может выполнять биннинг по времени, расстоянию, сетке, сообщениям и другим 
параметрам, задавая размер бина (например, 50 метров или 1 секунда). Биннинг может выполняться 
непосредственно в окнах карты, таблицы и статистики либо предварительно с генерацией данных. 

6.2 Определение шаблона биннинга данных 

Перед выполнением биннинга необходимо определить шаблон, включающий: 

размер бина; 

единицу бина; 

режим расчёта значения. 

Шаблон можно использовать повторно. 

1. Перейти в раздел Filter и выбрать Bin Template. 

Рисунок 6-1 Шаблон биннинга 

 

2. Открыть настройки шаблона через значок. 
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Рисунок 6-2 Настройки шаблона биннинга 

 

 

3. Выполнить настройку и сохранить шаблон. 

Шаблоны можно редактировать  или  удалять через соответствующие иконки. 

Рисунок 6-3 Редактирование и удаление шаблона 

 

6.3 Формирование данных после биннинга 

6.3.1 Биннинг в окне карты 

1. Загрузить данные в окно карты. 
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Рисунок 6-4 Загрузка данных 

 

2. Перетащить шаблон биннинга в окно карты — отображение данных обновится. 

Рисунок 6-5 Отображение данных после биннинга 

 

6.3.2 Биннинг в табличном окне 
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1. В окне таблицы активировать панель фильтрации и биннинга. 

Рисунок 6-6 Табличное окно 

 

2. Выбрать шаблон биннинга из выпадающего списка. 

Рисунок 6-7 Выбор шаблона 
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3. Переключить режим отображения между исходными данными и данными после 
биннинга. 

Рисунок 6-8 Отображение данных 

 

6.3.3 Биннинг данных в окне статистики 

В данном случае окно статистики — это окно, открываемое через контекстное меню (по правому 
клику мыши). Следуйте инструкциям ниже для формирования данных после биннинга в окне 
статистики: 

 

Рисунок 6-9 Функции контекстного меню 

 

1. Нажмите на стрелку раскрывающегося списка рядом с пунктом «Биннинг», чтобы 
выбрать шаблон биннинга. 

mailto:info-site@akmetron.ru


97 Тел: +7 (495) 252-00-96 

Email: info-site@akmetron.ru 

Адрес: Москва, ул. Рабочая, д.93 

стр.2, под. 2. 
 

 

 

Рисунок 6-10 Выбор шаблона биннинга 

 

2. Нажмите кнопку рядом с «Исходные данные» для отображения данных после биннинга. 
При этом режим «Исходные данные» изменится на «Применить». Пользователь может нажать 
кнопку повторно для возврата к отображению исходных данных. 

Рисунок 6-11 Отображение исходных данных или данных после биннинга 
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7 Техническая поддержка и контактная информация 

7.1 Техническая поддержка 

 

 Для любых проблем, связанных с удобством использования продукта, возникающих в процессе 
работы, обратитесь к руководству пользователя. Если проблему невозможно решить или 
необходимая информация отсутствует, пожалуйста, свяжитесь с нами по указанным ниже 
контактным данным. 

 

 

 

 

 

 

7.2 Ссылка на DingLi 

Для получения дополнительной информации о продукте, а также сервисной и технической 
поддержки, посетите сайт: www.dingli.com 

Область E-mail 

Глобальная support@dingli.com 
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